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GIMP, l’outil libre de référence pour l’édition et la retouche d’image, est sorti dans sa version 2.10.14 le 30 octobre 2019, puis 2.10.18 le 24 février 2020. Il s’agit d’une annonce combinée pour ces deux sorties parce qu’on a trop tardé pour cette dépêche !


Les yeux acérés auront remarqué qu’une troisième version semble avoir sauté (2.10.16). Cela est dû à un bogue critique découvert juste après la sortie, donc on est passé directement à GIMP 2.10.18 quelques jours plus tard, sans annoncer officiellement la 2.10.16.


Ces sorties s’accompagnent de nombreuses nouvelles fonctionnalités attendues, telles que l’édition hors canevas, ainsi que l’habituelle stabilisation et correction de bogues.


[image: Wilber déborde de la toile]
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	Le futur de GIMP



GIMP 2.10.14 apporte notamment :



	la visualisation et l’édition des pixels en dehors du canevas ;

	la possibilité d’éditer des calques désactivés ;

	un mode d’aperçu en nuances de gris pour l’outil de sélection de premier plan ;

	un nouveau filtre carte de normales ;

	la gestion des tampons GEGL pour vingt‑sept anciens filtres ;

	des améliorations dans la prise en charge des formats HEIF, TIFF et PDF ;

	une meilleure gestion des fichiers XCF corrompus ;

	une accélération des traitements en nuances de gris ;

	la compatibilité avec macOS Catalina ;

	quarante‑cinq corrections de bogues et vingt‑deux mises à jour de traduction.




De leur côté, GIMP 2.10.16/2.10.18 viennent avec :



	des outils groupés dans la boîte à outils ;

	des éléments de curseurs plus compacts ;

	des prévisualisations de transformation améliorées ;

	une zone d’ancrable qui « s’allume » quand on glisse un ancrable ;

	nouvel outil de transformation 3D ;

	une optimisation des déplacements de brosses pour un travail de peinture plus fluide ;

	des améliorations de la peinture en symétrie ;

	un chargement plus rapide des brosses ABR ;

	une meilleure prise en charge du format PSD ;

	l’amélioration de l’interface pour la fusion et l’ancrage de calques ;

	la vérification des nouvelles sorties ;

	vingt‑huit corrections de bogues et quinze mises à jour de traductions.



GIMP 2.10.14

La vue et l’édition hors canevas


Le canevas est le support de l’image. Par défaut dans GIMP, la taille du canevas coïncide avec la taille de l’image. L’impossibilité de visualiser et de modifier du contenu hors de cette zone était rédhibitoire pour certains usages, cette nouvelle fonctionnalité est une avancée majeure pour de nombreux graphistes.


Comment ça marche :



	il existe maintenant un nouveau mode Afficher tout, accessible via le menu Afficher, qui révèle tous les pixels en dehors de la limite de la toile ;

	ce mode utilise un damier alpha pour le remplissage de la toile, mais vous pouvez configurer GIMP pour utiliser temporairement ou de manière permanente la couleur de remplissage habituelle ;

	vous pouvez également activer l’affichage des limites de la zone de dessin (ligne rouge en pointillé) ;

	la sélection des couleurs et des correctifs, le remplissage et la transformation fonctionnent maintenant en dehors de la zone de travail ; cela signifie que vous pouvez recadrer au‑delà de la limite de la zone de travail ou sélectionner un motif source en dehors de cette zone pour corriger une cible dans le canevas.




[image: Contenu visible avec le mode « Afficher tout »]


Il ne s’agit là que d’un premier jet, d’autres outils devraient bientôt permettre d’exploiter le contenu hors du canevas.

Un mode « image » dans les outils de transformation


Ce nouveau mode permet, lors d’une transformation d’une image monocouche, d’agrandir automatiquement le canevas afin d’inclure tous les pixels pivotés ou déplacés, au lieu d’effectuer un rognage, action par défaut du mode Ajuster. Le commutateur est situé juste à côté de l’option pour transformer Calque, Chemin ou Sélection, en haut des paramètres de l’outil de transformation.


Il est complété par une nouvelle entrée de menu Image > Transformer > Rotation arbitraire…, qui active l’outil de rotation en mode Image.

Les filtres peuvent fonctionner hors limites du calque en cours


Certains résultats de filtres peuvent dépasser les limites du calque d’origine. Un exemple typique est l’Ombre portée (Drop Shadow). Les calques sont désormais redimensionnés si nécessaire au lieu de couper le résultat du filtre.


[image: Calques redimensionnés en appliquant un filtre]


Ce comportement peut être paramétré avec l’option Rognage (Clipping) des dialogues d’effets.

Calques invisibles éditables


Certaines personnes voulaient pouvoir éditer des calques sans les rendre visibles (par défaut, un calque invisible n’est pas éditable ; cela évite des erreurs si l’on retouche un calque par erreur, mais on ne s’en aperçoit que plus tard car il est invisible, et c’est alors trop tard pour annuler !).

Une option a été ajoutée pour cela dans les préférences (désactivée par défaut car c’est potentiellement un risque, mais activable pour qui a ce besoin).

Amélioration de l’outil de sélection à main levée


L’outil de sélection à main levée prend maintenant en charge la copie et la coupe rapide sur canevas, même quand la sélection n’a pas encore été validée, de la même manière que les autres outils de sélection.


Cela permet de faire des copier‑coller ou des couper‑coller très rapides directement sur le canevas.

Amélioration de l’outil d’extraction du premier plan


Un nouveau mode Niveau de gris de prévisualisation pour l’outil d’extraction du premier plan fait son apparition. Cela permet de prévisualiser le masque de sélection en niveaux de gris plutôt qu’en bleu. L’ancien mode unique s’appelle désormais Couleur et quatre couleurs peuvent être sélectionnées (rouge, vert, bleu ou gris). Cela permet d’adapter la visualisation de la sélection en cours à différent type d’images.

Meilleur « adoucissement de la sélection »


La boîte de dialogue de l’adoucissement de sélection a une nouvelle case Les zones sélectionnées continuent en dehors de l’image de manière similaire aux fonctionnalités de Réduction de la sélection et Border la sélection.


Quand cette case est cochée, les pixels sélectionnés en bordure de l’image se comportent comme si l’image continuait hors de ses frontières. Cela permet de ne pas se retrouver avec un adoucissement en bordure de calque, ce qui n’est pas forcément ce que l’on recherchait.

Nouveaux filtres


Un nouveau filtre de Carte normale (Normal map) fait son apparition.


[image: Filtre « Normal map » de GIMP]


En outre, diverses opérations GEGL ont maintenant un accès direct dans GIMP :



	
Matrice de Bayer (Bayer Matrix) et Sinusoïde linéaire (Linear Sinusoid) sont disponibles dans Filters > Render > Pattern ;

	
Papier journal (Newsprint) dans Filters > Distorts est une version GEGL du filtre historique ;

	
Flou courbure moyenne (Mean Curvature Blur) est utile pour un flou protégeant les bords.




D’autres opérations GEGL remplacent maintenant leur ancestraux greffons équivalents : Neon (Filters > Edge‑Detect), Stretch Contrast (Colors > Auto) et Oilify (Filters > Artistic).


Enfin, vingt‑sept vieux filtres ont été portés vers GEGL, en 8 bits seulement pour l’instant (toujours sous la forme de greffons, pas des opérations GEGL natives, utilisant néanmoins des tampons GEGL). Le filtre Van Gogh a, quant à lui, été porté en haute densité de couleur (jusqu’à 32 bits par canal, en flottant).

HEIF, TIFF et PDF améliorés


L’importation et l’exportation en format HEIF prend maintenant en charge les profils de couleur, avec case à cocher adéquate dans la boîte de dialogue d’exportation.


L’importation du format TIFF demande maintenant comment traiter les canaux additionnels (qui peuvent être n’importe quel type de donnée, sans sémantique donnée par le format), notamment en proposant de les utiliser comme canal alpha pré‑multiplié ou non ou l’importer comme canal nommé générique. Cela corrige un bogue avec certains fichiers TIFF à quatre canaux et permet de gérer plus de cas particuliers en laissant la possibilité de choisir comment traiter des données sans sémantique attachée.


Les calques de textes à l’intérieur d’un groupe sont maintenant correctement exportés en PDF.

Une meilleure gestion des fichiers XCF corrompus


Jusqu’ici, GIMP s’arrêtait à la première incohérence dans un fichier XCF. Ainsi, on aurait pu avoir un fichier de cent calques dont le premier calque était corrompu et ainsi perdre les quatre‑vingt‐dix‑neuf autres, alors que ces derniers auraient pu être « sauvés ». GIMP essaye dorénavant de continuer l’ouverture d’une image partiellement corrompue, afin de récupérer ce qui peut l’être.

GIMP 2.10.16/2.10.18


[image: GIMP groupe les outils]

Groupement des outils par défaut


Au fil des années, nous avons rajouté encore et encore des outils, ce qui rend GIMP plus puissant mais peut rendre compliqué de retrouver ses marques.


Maintenant, les outils sont groupés par défaut (outils de sélection ensemble, outils de peinture ensemble, etc.) ce qui donne une boîte à outils moins « bordélique ».


[image: Outils de GIMP groupés]


On notera que les groupes peuvent être désactivés dans les préférences, de même que vous pouvez y réorganiser les outils, leur ordre, créer ou retirer des groupes, etc. C’est ce que faisaient déjà avant les professionnels ou amateurs éclairés (sauf le groupement bien sûr), par exemple pour ne voir que ses outils préférés ou habituellement utilisés, ou bien l’inverse puisque les outils préférés auront en général un raccourci bien connu. Notons aussi que l’absence d’un outil dans la boîte à outils ne l’empêche pas d’être sélectionné (par raccourci, par menu ou par la recherche d’action par exemple).

Curseurs compacts


Le widget curseur de GIMP prenait beaucoup d’espace vertical, avec une interaction basée sur une partie supérieure (modification rapide de valeur) et inférieure (modification lente).


Cela a été changé par défaut, bien que l’on puisse retrouver l’ancien design des curseurs par une option dans les préférences, pour les nostalgiques.


[image: Nouveaux curseurs de GIMP]


La modification rapide ou lente peut maintenant se faire avec des modificateurs et le bouton primaire (gauche par défaut) de la souris ou avec la molette :



	clic + glisser pour changer la valeur avec incrémentation normale ;

	
Maj + clic + glisser (ou clic secondaire/droit + glisser) pour une incrémentation faible ;

	
Ctrl + clic + glisser pour une incrémentation rapide.




Voici une référence plus complète en image :

[image: Référence pour nouveau curseur de GIMP]

Amélioration du système d’ancrable


Le petit texte « Vous pouvez déposer les fenêtres ancrables ici » qui s’affichait sous la boîte à outils en cas d’absence d’ancrable a finalement été retiré. Avoir seulement une boîte à outils d’un côté est une organisation tout à fait valide et afficher un texte permanent était une mauvaise idée en plus de poser problème.


Maintenant, en glissant un ancrable, toutes les zones de dépôt possibles seront simplement illuminées comme indice que l’ancrable peut être réorganisé de cette façon. Voir aussi cette petite vidéo de démonstration.

Nouveau thèmes d’icônes au contraste élevé


Certaines personnes souhaitaient un thème d’icônes avec un contraste un peu plus important, même si beaucoup apprécient les thèmes existants (trop de contraste est aussi un risque de focaliser trop le regard sur l’interface, ce qui peut être contre‑productif dans un logiciel d’imagerie).


De nouveaux thèmes d’icônes au contraste supérieur ont ainsi été rajoutés et sont donc maintenant disponibles dans les préférences.


[image: Changer le thème d’icônes]


Il s’agit d’une solution non idéale qui correspond aux limitations de GTK+ 2. Idéalement avec GIMP 3, nous pourrons proposer de meilleurs moyens d’augmenter le contraste des thèmes d’icônes symboliques.


Accessoirement, les indicateurs de couleur d’avant‑plan ou d’arrière‑plan ont maintenant une bordure blanche ou noire, les rendant donc visibles quelle que soit la couleur de l’interface.

Prévisualisation des transformations améliorée


La plupart des outils de transformation ont maintenant l’option Composited Preview qui permet d’avoir un rendu de prévisualisation avec la composition réelle (en fonction de la position dans la pile de calque, de même que la prise en compte des modes de calque adéquats) Vidéo démo.


Cette option est accompagnée de deux sous‑options :



	
Preview linked items active la prévisualisation des éléments liés (bouton « chaîne » dans la pile de calque) vidéo démo ;

	
Synchronous preview active le rendu synchronisé de la prévisualisation pendant le déplacement du curseur au lieu d’attendre que le mouvement s’arrête ; cela permet un aperçu immédiat de sa transformation, ce qui n’est pas toujours possible, notamment pour de très gros et très nombreux calques avec une composition complexe.




GIMP affiche aussi désormais la prévisualisation du rognage de calques transformés, ce qui évite les mauvaises surprises après validation.

Outil de transformation 3D


Un nouvel outil de transformation 3D fait son apparition pour changer la perspective d’un calque ou le déplacer dans un espace 3D. Vous pouvez décider d’un point de fuite puis déplacer le calque sur les axes X, Y et Z vidéo démo.


Divers modificateurs sont aussi disponibles pour contraindre la rotation et les déplacements sur un axe seulement.

L’option Unified interaction permet de modifier le point de fuite, de même que la rotation et le déplacement, sans avoir à changer d’onglet dans la boîte de dialogue.

Enfin, l’option Local frame permet de contrôler la transformation dans le cadre de référence local du calque plutôt que dans le cadre de référence global.

Amélioration du mouvement et de qualité des brosses


Le déplacement du contour des brosses apparaît maintenant bien plus fluide après avoir monté la fréquence de rafraîchissement de 20 images par seconde jusqu’à 120 images par seconde au maximum, de même qu’en désactivant l’ajustement des coups de pinceau (nouvelle option, désactivée par défaut). L’ajustement des coups de pinceau peut être réactivé dans l’onglet « Fenêtres d’images » des préférences vidéo démo.


En outre, la fréquence de peinture de l’outil Aérographe a été augmenté de quinze jusqu’à un maximum de soixante « tamponnages » par seconde, fluidifiant là encore l’expérience de peinture.


Enfin, pour améliorer la qualité des brosses raster rétrécies (en peignant à une taille inférieure à la taille par défaut), les outils de peinture utilisent maintenant du MIP mapping pour rétrécir les brosses raster. Cela réduit le crénelage des brosses rétrécies pour ainsi produire des traits de meilleure qualité.

Amélioration de la peinture en symétrie


Le mode de symétrie « Mandala » propose maintenant une option Kaléidoscope qui combine la rotation et la réflexion vidéo démo. Quand l’option est cochée, des traits additionnels en miroir s’ajoutent.

Chargement plus rapide des brosses ABR


GIMP prend en charge le format de brosse de Photoshop (ABR) depuis très longtemps. Dans cette version, la lecture de ces fichiers a été améliorée rendant le chargement beaucoup plus rapide, au cas où vous utilisiez beaucoup de ces brosses.

Meilleure prise en charge du format PSD


La lecture des fichiers PSD a aussi été énormément optimisée, de l’ordre de 1,5 à 2 fois plus rapide dans nos tests limités. En outre, GIMP peut maintenant charger des fichiers PSD en CMYK(A) (seulement 8 bits par canal pour l’instant), qu’il convertit en RGB avec le profil sRGB seulement dans cette première version.


Ce greffon est le premier à utiliser la récente prise en charge de CMYK dans babl (la bibliothèque de conversion de formats de GIMP) et annonce donc l’entrée progressive de plus de vraie prise en charge de ce modèle de couleur dans GIMP. Il ne s’agit toutefois que d’un tout premier pas.

Amélioration de l’ancrable de calques


Le bouton d’ancrage d’un calque flottant n’est désormais visible que lorsqu’un calque flottant est présent. Autrement un bouton de fusion de calque est affiché à la place, pour une action plus rapide, évitant ainsi d’avoir à aller chercher dans le menu contextuel ou d’avoir à se souvenir du raccourci pour cette action.


[image: Boutons ancrage et masque de calque dans GIMP]


Les modificateurs suivants sont aussi disponibles sur le bouton de fusion :



	
Maj pour fusionner un groupe de calques ;

	
Ctrl pour fusionner tous les calques visibles ;

	
Ctrl + Maj pour fusionner tous les calques visibles avec les dernières valeurs utilisées.



Vérification de nouvelle version


GIMP peut maintenant vérifier lors du lancement si une nouvelle version est sortie et vous en avertir. Il peut aussi vérifier la présence d’un nouvel installateur ou paquet (pour Windows ou macOS) d’une même version, utile dans le cas de corrections dans le paquet ou une dépendance.


Cette fonctionnalité est notamment utile pour les rapports de bogue puisque nous recevons régulièrement des rapports sur de vieilles versions non prises en charge. Nous sommes en effet bien trop peu de développeurs et n’avons pas le loisir de prendre en charge plus que la dernière version sortie (un jour peut‑être une LTS ou que sais‑je, mais à ce jour, c’est impensable). Nous espérons donc à terme ne plus voir trop de GIMP totalement obsolètes dans la nature.


Bien entendu, cette fonctionnalité est désactivable dans les Préférences et peut être retirée à la compilation avec --disable-check-update, ce qui est notamment conseillé pour tout paquet qui vient avec son propre canal de diffusion (comme les paquets de distribution GNU/Linux).

Autour de GIMP

Version macOS améliorée… puis absente…


macOS Catalina est venu avec son lot de changement, notamment des permissions d’accès aux ressources (la nouvelle tendance dans tous les système d’exploitation, avec diverses formes de bac à sable et permissions). Cela a fait beaucoup crier dans les chaumières puisque nombre de logiciels sont devenus inutilisables du jour au lendemain après mise à jour du système d’exploitation.


Nous avons donc dû faire évoluer l’empaquetage de GIMP, qui fonctionne maintenant correctement sur Catalina depuis GIMP 2.10.14. Diverses autres corrections de bogues d’empaquetage ou d’intégration ont également été faites par notre empaqueteur macOS.


Malheureusement notre mainteneur de paquet macOS a disparu pour raison personnelle après la sortie de GIMP 2.10.18. Ainsi, à l’heure actuelle, la dernière version officielle pour GIMP sur macOS est la 2.10.14. Aucun des autres contributeurs au long cours n’est vraiment intéressé par macOS. Nous avons récemment de nouveaux contributeurs qui pourraient continuer à faire vivre ce paquet (et nous espérons aussi que le contributeur précédent revienne et que nous ayons plus de redondance dans le futur), mais nous restons dans l’expectative.


Cela montre vraiment le manque de contributeurs pour ces systèmes d’exploitation que sont macOS et Windows, pour lesquels nous n’avons presque aucun développeur.

Intégration continue

Compilation pour Windows en intégration continue


Nous effectuons maintenant des compilations coisées de GIMP pour Windows (32 bits et 64 bits) en intégration continue, ce qui nous permet de repérer rapidement les bogues pour cette plate‑forme qu’aucun des développeurs n’utilise, et possiblement d’améliorer le suivi et la stabilité de GIMP sur Windows.


La compilation coisée se fait avec mon outil d’environnement de cross‐compilation Crossroad (j’en avais parlé sur LinuxFr.org il y a pas mal d’années ; je pense que je devrais refaire un nouvel article bientôt, car cela a beaucoup évolué depuis).

Compilation avec plusieurs systèmes de construction et plusieurs compilateurs


Pour attraper un plus grand nombre de bogues, notre intégration continue compile maintenant avec GCC ainsi que Clang (certains bogues n’apparaissent qu’avec certains compilateurs), et avec les systèmes de construction autotools et meson (autotools est toujours le système officiel que nous recommandons aux mainteneurs de paquets tiers d’utiliser ; notre build meson étant de son côté expérimental avec encore quelques bogues connus).

Le futur de GIMP


Comme toujours, nous concluons avec un peu d’information sur le développement. GIMP est développé par une poignée de développeurs permanents (trois principalement, Mitch, Ell et moi‑même pour environ les trois quarts des commits sur les dernières années), assisté par plusieurs mainteneurs de rapports de bogue, et des gens qui aident pour le site, les réseaux sociaux, la documentation et bien sûr de nombreux traducteurs.


C’est donc un travail de longue haleine et, personnellement, je trouve qu’il porte de plus en plus ses fruits. Pour la deuxième année consécutive, Aryeom du projet ZeMarmot (qui est aussi celui par lequel j’ai commencé à contribuer à GIMP, devenant ainsi un contributeur majeur) a donné des cours avec GIMP à l’université (ce qui lui fut explicitement demandé). Et étudiants comme professeurs sont très contents du résultat.


Il nous semble évident que GIMP est de plus en plus reconnu comme incontournable (il était déjà connu de tous, mais la notoriété se fait de plus en plus sentir).


Le développement de ce qui deviendra GIMP 3 bat aussi son plein en parallèle des sorties des GIMP 2.10.x, avec beaucoup de nouveautés excitantes aussi (celles qui ne peuvent être aisément rétroportées). Il s’agit de tout un travail de fond, invisible mais extrêmement actif. En fait, le mainteneur et moi‑même déplaçons clairement nos priorités progressivement sur le développement de GIMP 3 ces derniers temps.


Si vous souhaitez que cela continue, nous ne saurions que trop vous rappeler qu’il est aussi possible de donner au projet. Vous pouvez donner au projet directement, en sachant que cet argent ne peut être utilisé que pour les actions communautaires (faire se rencontrer les développeurs notamment) ainsi que pour financer du matériel. Ce sont des choses néanmoins importantes bien sûr.


Pour financer du développement proprement dit, il existe actuellement deux groupes qui lèvent des fonds pour vivre de l’amélioration de GIMP : pippin le développeur de GEGL, le moteur graphique de GIMP, et nous‑même, le projet ZeMarmot, sous le parapluie de l’association LILA, qui finance mon développement (2 180 commits dans l’arbre de développement principal de GIMP, second plus gros contributeur des huit dernières années et troisième plus gros contributeur historique), lequel est porté par une utilisation professionnelle et les idées et design d’une réalisatrice et illustratrice professionnelle.

Voici par exemple un compte‑rendu de travail en cours sur l’implémentation de sélection multiple de calques dans GIMP pour avoir une idée de ce sur quoi on travaille ces derniers temps.


Vous pouvez donc donner à l’association directement, ou au projet ZeMarmot sur Liberapay, Patreon ou Tipeee et ainsi contribuer à payer du développement pour GIMP.


Nous rappelons que vous pouvez aussi contribuer du votre, que ce soit du développement comme de la documentation, ou le site Web (articles, tutoriels, etc.), et sûrement bien plus.


Dans tous les cas, nous vous souhaitons à tous un joyeux GIMPage de photo ! 😃


Aller plus loin


	
Annonce officielle de GIMP 2.10.14
(105 clics)


	
Annonce officielle de GIMP 2.10.18
(126 clics)


	
Dernière annonce (2.10.12) sur LinuxFr.org
(71 clics)


	
Donation à GIMP
(65 clics)


	
ZeMarmot (moi‑même, développeur de GIMP) sur Liberapay
(107 clics)
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